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Background:

Subscribers registered with CRA are allowed to update the existing details in the available CRA
system. For the purpose of carrying out these changes, Subscriber has to submit a Subscriber
Detail Change Request form (S2 form) to the concerned PAO/DTO. The said form is available at
CRA website wherein the subscriber can download the S2 form.

Link for site is : https://npscra.nsdl.co.in/

The subscriber is required to go through below mentioned option

Home -- 2>Central Government/State Government-- = Forms-- = NPS Account Maintenance-- 2>Form S2:
Subscriber Details Change

NPS Account Maintenance

© Form S2 : Subscriber Details Change

® Form S7 : Subscriber's Photo and Signature Change

© Form S8 : Covering Letter of DDO for Change in Photo and Signature of Subscriber
©® PAN & Aadhaar Updation Form

© Form ISS - Inter Sector Shifting

Nodal office can update below mentioned details of subscriber in the CRA system by through login
its User IDs.

Email ID and Mobile number

Address details

Nomination details

Bank Details

Flow Matrix for Processing Change Request
(Email ID/Mobile Number/ Address Details /Nomination and Bank Details)

Request Initiation Authorization
PAO/DTO (User 1) PAO/DTO (User 2)



https://npscra.nsdl.co.in/
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The subscribers can submit the documents for change request to concerned DDO office. Based
on the availability of option, DDO office may initiate the subscriber details change request in CRA
log in and forward to DTO/PAO office for further verification/authorization. If DDO has no access
for processing any modification, the office needs to send the request the concern DTO/PAO.

It is the responsibility of the office to check veracity of documents as provided by the subscriber
before processing any modification in the system.

Updation of core details in PRAN

For updation in core details i.e. Name/DoB/ DoJ and DoR, the same can be updated by Nodal office

only through its login. For the same, a separate SOP is available namely “SOP for updating
Subscriber details_V_1.2". The offices are requested to refer the same for updation of core details.



https://npscra.nsdl.co.in/download/government-sector/central-government/Standard-Operarting-Procedures-for-Nodal-Offices/nodal-offices/12.%20SOP_Subscriber_Details_Update_%20Version%201.2.pdf
https://npscra.nsdl.co.in/download/government-sector/central-government/Standard-Operarting-Procedures-for-Nodal-Offices/nodal-offices/12.%20SOP_Subscriber_Details_Update_%20Version%201.2.pdf
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Subscriber based Journey:

Subscribers registered under NPS also have an option to initiate the request for updation of their
personal details such as address, mobile number, email ID, bank account and nominee details in
CRA System using the I-PIN provided to them by CRA. Alternatively, the subscriber can provide the
request to nodal office and nodal office would initiate the request on behalf of its subscribers
based on documents received.

The steps for modification of these details thorough subscriber end are mentioned below.

(Please note for updation of address/contact details/ mobile, these details can get updated
through self authorisation based on OTP/e-sign and in case of bank /nominee details, the
modification request is required to be verified and authorised by nodal office as mentioned in
SOP).

» Steps for updation of contact/email details of subscriber
o Login into CRA using user id & password
Under Manage my Account, Click on Update my Profile
Click on Change contact details
Subscriber can update : Email id or Mobile no
Click in Email id/Mobile no, enter the new details
Click on Submit button, Click on Proceed button
OTP will be sent to New Mail id/Mobile no.
After entering the OTP, the details will be updated

In case, if newly updated email id or mobile no is already exist in CRA system, error will be shown
to the subscriber about duplicity.

> Steps for updation of address details of subscriber

o Login into CRA using user id & password

o Under Manage my Account, Click on Update my Profile and click on Change Address

o Subscriber can update the address through Aadhaar number or PAN no. (in case of PAN
no, CKYC details should be updated)
Enter the Aadhaar Number & click continue.
OTP will be sent to registered Mobile no. once the OTP is entered Old & new address will
be show to subscriber
Click on generate OTP, enter the OTP.

» Steps for updation of Nominee details of subscriber
o Logininto CRA using user id & password
Under Manage my Account, Click on Update my Profile, Click on update nomination
Click on update nominee details.
Update the nominee details, click on submit.
On submission, OTP will be sent to registered mobile no. on submission of OTP ack id will
generated & same need to be verify/ authorize by nodal office.
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» Steps for updation of Bank details of subscriber

o

Login into CRA using user id & password

Under Manage my Account, Click on Update my Profile,

Click on update Bank details - Tier 1/ Tier 2

Select Type of Transaction - Modify Bank Details

The existing bank details will be shown to the subscriber. Also, the subscriber is requested
to enter new bank details.

The Govt. subscriber need to tick on the following declaration

“I hereby declare that my NPS Bank account is my salary bank account and atleast one salary
has been credited”

The subscriber is required to do penny drop for updated bank account.

On successful penny drop, Ack id will get generated and the same need to be verify/
authorize by nodal office.
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A. Process to Update Subscriber i.e. Email ID/Mobile Number/Address Details

A.1 Request initiation by PAO/DTO office Nodal Office User 1 (Maker)
1. Log in to https://npscan-cra.com/CRA/. Enter PAO/DTO office user Id and password. Click
on “Submit” (Refer figure 1)
Figure 1

@INSDLe-Gov i5 now EEE?%?E National Pension System Contributions Accounting Network

vide training on NPS. Government Nodal officers can Click here to submit requests on behalf of subscriber to parficipate in these training

Nodal Offices / Other Intermediaries
1001003100

Annual Transaction Statement on Email

User ID

[T

Password
My Withdrawal Utility
Enter Captcha 2 4+ ) =30

v
Invest in NPS 821 understand that,

« My User ID/FRAN & Password is confidential & not to be disclozed.
« Password should be complex and not commonly used text or
number.

Activate Tier Il Account. | T « | need to keep changing my password regularly.
ree 1!

FATCA Compliance Help/instructions for Login

Reset Password

P,

2. Click on menu “Transaction”-> “Update Subscriber Details” (Refer figure 2)
Figure 2

Office-1001003101 Navigate to CRA 18-Dec-2024 Home | Logou

-ﬂw s now Oprotean National Pension System Contributions Accounting Network

Welcome Pay and Accoyg

Contribution Defails  Transaction Security  Subscriber Maintenance Views  Tranche2/Regular Fund Dtls  Additional Reporis (New)  Nodal Officer Defails  Aadhaar Linking
Authorize Transaction

Update Subscriber
Details

Request Status - View

Subscriber Bank Details Welcome to Central Recordkeeping Agency
Update

Subscriber Personal

Details Update Click here to view list of pending withdrawal request

Subscriber is required to purchase the annuity at the time of Exit. To view annuity quotes, please click here View Annuity Quotes

Click here for details related to “Voluntary Contribution in Tier | account by Govt. Sector Subscribers’
Information regarding online submission of FATCA Self-Certification in Subscribers login may be disseminated to your Subscribers. For details, Click here
Click here for PFRDA Advisory on streamlining of handling of Exit cases

NPS Operations Guide PAQ/DTO DDO



https://npscan-cra.com/CRA/
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3. Enter PRAN of subscriber under “Subscriber Details View"” option. Click on “Submit”
(Refer figure 3)

Figure 3

(NDL eGov s now Qprotean National Pension System Contributions Accounting Network

Change /s growth
Welcome Pay and Accounts Office-1001003100 Navigate to CRA 17-Dec-204 Home | Logout
Contribution Defails  Transaction ~ Security  Subscriber Maintenance ~ Views  Tranche2/Regular Fund Dtis  Additional Reports (New)  Nodal Officer Defails ~ Aadhaar Linking

»  Subscriber Details View

* Mandatory Fields

PRAN * | 10040340037

4. Click of “Edit” option to enter New details. (Refer figure 4)

Figure 4

OINSDL e-Gov is now protear_l National Pension System Contributions Accounting N¢

Change (s growt

Welcome Pay and Accounts Office-1001003101 Navigate to CRA 18-Dec-2024 Home |
Contribution Details  Transaction Security  Subscriber Maintenance  Views  Tranche2/Regular Fund Dils  Additional Reports (New)  Nodal Officer Defails ~ Aadhaar Linking

3 Subscriber Details

110178296534  [Status: Active |

Name KUMARI DHANANYAPERBAK PATHE
PRAN activation date 2110/2024

For Bank Details modification - Use New link 'Update Bank details’
<a

Personal Details
Nomination Details

Bank Details
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5. To check the existing personal details please click on Personal Details tab. (Refer figure 5)

Figure 5

Ormeqor isnon (ggPFotean National Pension System Contributions Accounting Netw

Welcome Pay and Accounts Office-1001003101 Navigate to CRA 18-Dec-2024 Home | Log
Contribufion Details ~ Transaction  Securify  Subscriber Maintenance  Views  Tranche2iRegular Fund DHs  Addifional Reports (New) — Nodal Officer Defails ~ Aadhaar Linking

»  Subscriber Details

* Mandatory Fields
PRAN 10170498534 [Status: Active |
muzrd No. [

View Signafure

Personal Details
Nomination Details
Employment Details

KYC Details

6. Existing personal details can be viewed under Personal Details tab (Refer figure 6)

Figure 6

Subseriber's
Maiden Mame

Marital Status

Flace of Birth * Country of Birth = [Gaban
250211998
{dd/mmiyyyy )

LandLine {(Offica) Date of Barth =

PAN [POORYSEEI Yy | Click for Pan Verfication

Gender * MALE -

Lo Iaaaaa— le Mo = [feezzmezn ] [Fe5=ATgchb4B54E55850 |
STD Code Mobile Mo. r462248320 fwhed7gchb4654855850@F

SMS i
Subseripiion Fag i
s

Mationality * [Ind= w | Residential Status SELEC

Cancelled -
Cheque Flag NR Flag NO

US Person Flag 0w RI Flag
Diocumnent

evidencing SELECT
Citizenship Flag

Formn 60 Flag 8] ot

Current Address:

Address Line 1%
Adress Line 2
City/ Town/village

bl Reason for no Evidence

Diistrict CITY

Fincode =
Statenion [Goa

Territary *
Country * [Ind=a
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7. Please enter new detail in respective field and click on “Submit”. In case mobile number/email
ID details already exists in CRA records, system will prompt an error “Duplicate Mobile Number
Already Exists in CRA system.” The office needs to check with the subscriber for the said duplicity

and request for another mobile number for updation if available. (Refer figure 7 & 8)

Figure 7

Citizenship Flag

Form G0 Flag [e] W

Current Address:

Adress Line 1 =
Address Line 2
City/Townfillage

District amy

Fincode *

State/Union Goa v

Territory *

Country * [ndia W]

Address Type

=t = (I
Voter id 1 Number

Curmrent Status of ey v Remarks l:l

Subscriber

Nomination Details

Employment Details

KYC Details :

Figure 8

pnsaction  Authorize Request  Contribution Details Security  Account Details Subscriber Registration  Grievance User Maintenance Document Management  Views Reports  Additional Reports (New)  Master Dd

jshboard Subscriber Deactivation / Reactivation CGMS BackOffice Nodal Offices Upload Error Rectification Module CSRF Submission Details Exit Withdrawal Request Recruitment Monitoring Annual Freezing Kno

Duplicate Mobile Number already Exist in CRA System. Please try Different Mobile Number

¥ Subscriber Details

* Mandatory Fiekls
PRAN 110014675754 [Status: Active ]

inviard No. 1

View Sianature

8. Nodal office is required to Upload supporting Proof i.e. S2 Form signed by subscriber along

with supporting documents. (Refer figure 9 & 10)

Uploaded Attachment/Allowed file types: pdf/xIs/png/doc/xlIsx/jpeg/docx/zip/jpg.
Maximum File Size Limit: SMB.

Only 1 document can be uploaded.

File Name should not have special characters or space.

It is the responsibility of the office to check veracity of documents as provided by the
subscriber.
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Figure 9

OnsoLeGov s ow (@88 protean National Pension System Contributions Accounting Net

Change is growth
Welcome Pay and Accounts Office-1001003101 Navigate to CRA 18-Dec-2024
ribufion Details ~ Transaction  Security  Subscriber Maintenance  Views  Tranche?Regular Fund Diis  Addifional Reports (New)  Nodal Officer Defails ~ Aadhaar Linking

¥ Subscriber Details

PRAN 10172486534 [Status: Active |
Inward No.

Personal Details

Nominafion Details

Employment Details

KYC Defails

Document Upload

: > Select File to upload * Nofie chosen

{Note - Uploaded Attachment/Allowed file fypes : pdf xiz png doc xlax jreg docx 2ip jpg.
Maximum File Size Limit : 58, Number of Filez can be uplosded 1)
Kindly upload 52 Form. Form upload is mandatary for Subseriber Modification request

Figure 10

File uploaded successfully
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9. Updated details entered in CRA system will be highlighted in red color text. Office may verify
the details and click on “Submit” option. (Refer figure 11)

Figure 11

¥ Subscriber Details

110182887572 [Status: Active ]

Personal Details

PRAN 110162887572 [Status: Active | PAN EZGPWE585W
Mame SHRI CWVWH WeEWC Mother's Mame Flag NO

Father's Mame ZVHEMDEC WXZVC SOT Language ENGLISH
Mother's Mame TEEZW DEVH Last 4 digits of Azdhaar

Orphan NO

Gender MALE Date of Birth 17110/1906
Subseriber's Maiden Mame Spouse Mame

Marital Status MARRIED LandLine (Office)

Place of Birth ATELI Country of Birth

POP Consent flag NO

CERSAIID

Mationality Residential Status
Cancelled cheque Flag

US Person Flag

Document evidencing Citizenship Flag Reason for no Evidence
Ri Flag

Form 60 Flag PAM Seed Flag
Current Address:

Adress Line 1 WPO-hisjijxz ,

Adress Line 2 zakxlZ |

CityTown\illage

District REWARI

FinCode 123102

State/Union Temitary HARYAMA

Country MDA

Address Type RESIDEMTIAL

Telephone with STD Code

Maobile Mo. +018B87854310

‘SMS Subscription Flag YES Email Subscription Flag
Email Id efge@nsdl.co.in

[y Sr— [N [ -

10. Message will be displayed on screen once subscriber details change request are captured
successfully.
Acknowledgment number will be displayed on screen. (Refer figure 12)
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Figure 12

(INSDL e-Gav is now Opmtean National Pension System Contributions Accounting Network

Change is growth
Welcome Pay and Accounts Office-1001003101 Navigate to CRA 18-Dec-2024 Home | Logout

Contribution Details ~ Transaction  Security  Subscriber Maintenance Views  Tranche2/Regular Fund Dtis  Additional Reports (New)  Nodal Officer Details ~ Aadhaar

»  Subscriber Details Modification

PRAN 110179496534

The Subscriber Details Change request has been Accepted

PENDING AUTHORIZATION

Acknowledgement No. 2002006463
Capture Timestamp 20241218 12:30:21

11. Status of request can be checked under option: View---> Request Status -View-> Transaction
Type—> Enter PRAN/ Acknowledgment number (Refer figure 13,14 & 15)

Figure 13

Change is growth

©INSDL e-Gov is now Opmtean National Pension System Contributions Accounting Netw(

Welcome Pay and Accounts Office-1001003101 Navigate to CRA 18-Dec-2024 Home | Log«
Confribution Details  Transaction  Security  Subscriber Maintenance Views  Tranche2/Regular Fund Dis  Additional Reports (New)  Nodal Officer Details  Aadhaar Linking

Authorize Transaction

Update Subscriber Details
Request Status - View @
e RS Subscriber Details Modification

Subscriber Personal Details
Update

PRAN 110179496534
The Subscriber Details Changs request has been Accepted

PENDING AUTHORIZATION

Acknowiedgement No. 2002006463
Caplure Timestamp 2024-12-18 12:30:21

Figure 14

CINSDL e-Gov is now protean National Pension System Contributions Accounting Net

Change is growth
Welcome Pay and Accounts Office-1001003101 Navigate to CRA 18-Dec-2024 Home | Loy
onfribution Details  Transaction Security Subscriber Maintenance  Views  Tranche2/Regular Fund Dtis  Additional Reports (New) Nodal Officer Details  Aadhaar Linking

»  Status of Maintenance Request

* Mandatory Fields
Transaction Type
PRAN 110179406534
Ack No./PRN ==
Capture From Date 7
o B waimmiyyyy)

B (aammiyyyy)

Capture To Date [ —

Note

> Please enter the Ack No. or PRN/Receipt number provided by the Nodal Office/POP-SP at the time of submission of the Maintenance request
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Figure 15

ONsiLe-Gov s now (@) Protean National Pension System Contributions Accounting Network

Change is growth
Welcome Pay and Accounts Office-1001003101 Navigate to CRA 18-Dec-2024 Home | Logout
pnfribution Details ~ Transaction  Security  Subscriber Maintenance  Views  Tranche2Regular Fund Diis  Additional Reports (New)  Nodal Officer Defails ~ Aadhaar Linking

»  Status of Subscriber Change Request Status Results

DHANEMMN ERFASTRATHE
110179496534

Sr. No. Acknowledgement No. Request Received Date Request Type Status DDO Approved DDO Approval Date Auto-Processed Request Authorization Date Reason of Rejection
1 2002006463 18-12-2024 Subscriber Change Request Status  Pending Authorisation - No - -
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A.2 Request Authorization by PAO office Nodal Office User 2 (Checker/Authorizer)

12. Log in to https://npscan-cra.com/CRA/ and enter PAO/DTO user Id and password. Click on
“Submit” (Refer figure 16)

Figure 16

P Opr?teah National Pension System Contributions Accounting Network

PFRDA has appointed Traini to provide training on NPS. Government Nodal offi

Annual Transaction Statement on Email Nodal Offices / Other Intermediaries
User 1D 1001003100

Password
My Withdrawal Utility

Enter Captcha 3 ‘3 + 2 =35
L
Invest in NPS 81 understand that,
» My User ID/PRAN & Password is confidential & not to be disclosed.

» Password should be complex and not commonly used text or
number.

Activate Tier Il Account | i « | need to keep changing my password regularly.
ree 11

FATCA Compliance Reset Password Help/instructions for Login

Android

13. Click on menu “Transaction”-> “Authorize Transaction” (Refer figure 17)

Figure 17

National Pension System Contributions Accounting Network

Welcome Pay and Accountg Qffice-1001003100 Navigate to CRA 18-Dec-2024 Home

Contribution Details  Transaction Security  Sybscriber Maintenance Views  TrancheZ/Regular Fund Dtls  Additional Reports (New)  Nodal Officer Details ~ Aadhaar Linking
Authorize Transaction

Update Subscriber
Details

Request Status - View

Subscriber Bank Details Welcome to Central Recordkeeping Agency
Update

Subscriber Personal
Deals Update Click here 1o view list of pending withdrawal request

Subscriber is required to purchase the annuity at the fime of Exit. To view annuity quotes, please click here View Annuity Quotes

Click here for details related to "Voluntary Contribution in Tier | account by Govt. Sector Subscribers’

Information regarding online submission of FATCA Self-Certification in Subscribers login may be disseminated to your Subscribers. For details, Click here



https://npscan-cra.com/CRA/
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14. Enter “Transaction Type” and PRAN. Click on “Search” (Refer figure 18)

Figure 18

€INSDL e-Gov I now Oprotean National Pension System Contributions Accounting N

Welcome Pay and Accounts Office-1001003100 Navigate to CRA 18-Dec-2024 Home

Contribution Details  Transaction  Security  Subscriber Maintenance Views  Tranche2/Regular Fund Dtls  Additional Reports (New)  Nodal Officer Details ~ Aadhaar Linking

»  Authorize Transaction

* Mandatory Fields
Transaction Type * | Subscriber Details Change v |
PRAN [110179496534 |

AckNoPRN=* [ ]
From Date \:\ B (aammyyyy)

To Date 1 ﬂ (dd/mmiyyyy)

|:>@-

>  ** Enter PRN/Receipt No for Switch transaction and Ack No./Receipt No. for other transactions.

15. Click on Hyperlink “View Details” to check the new details entered by maker user. (Refer figure
19)

Figure 19

CINSDL e-Gov is now Oprotean National Pension System Contributions Accounting Network

Change is growth

Welcome Pay and Accounts Office-1001003100 Navigate to CRA 18-Dec-2024 Home | Logout

Contribution Details  Transaction  Security  Subscriber Maintenance  Views Tranche2/Regular Fund Dtis  Additional Reports (New}  Nodal Officer Details ~ Aadhaar Linking

»  Authorize Transaction

* Mandatory Fields

Transaction Type * | Subscriber Defails Change v
Pan
ronorrn=s [ ]

From Date |:| -@ (dd/mmiyyyy)
To Date 1 B (dd/mmiyyyy)

» ™ Enter PRN/Receipt No for Switch transaction and Ack No./Receipt No. for other transactions

Acknowledgement No Subscriber Name Date Of Request Capture DDO Approved DDO Approval Date Link to Details

2002006463 DHANANJAY SIRPAT PATHE 181212024 View Details

16. Click on personal details tab to check new updated details. Updated details are highlighted in
Red Color Text. (Refer figure 20)
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Figure 20

Back to Resulis Page

* Changes to be autl d are marked in red

PRAN 110179406454 X
Acknowledgement No. 2002006463
Inward Mo.

Personal Details

Nomination Details

Personal Details

PDOPYA45S81X
Mother MName
ENGLISH

PRAM 110179496534 PAM

MName KUMARI DHANANJAY SIRPAT PATHE Mother's Mame Flag
Father's Name VAISHALI SOT Language
Mother's Name VAISHALL Last 4 digits of Aadhaar
Orphan MNO

Gender MALE
Spouse Mame

Marital Status UNMARRIED
Country of Birth Gabon

POP Consent Flag NO
Mationality India
Cancelled Cheque Flag NO

US Person Flag NO RI Flag

Document evidencing Citizenship Flag Reason for no Evidence
Form &0 Flag NO PAM Seed Flag
Current Address:

Address Line 1 ADDS |,
Address Line 2 ADD4
CityMownNillage dumny

Disfrict CITY

Date of Birth
Subscriber's Maiden Name
Place of Birth

CERSAIID
Residential Status

Pincode
State/Union Territory
Country

Address Type

LandLine (Office)

Telephone with STD Code
Mobile No.

SMS Subscription Flag
Email Id

woter Id

Current Status of Subscriber

400064
SOs
TNDLA

+817499112233

YES Subseription Flag

fuSedTgchba6567 89 @proteantech.in Aadhar Seeding Flag
Passport Number
Remarks.

17. Office may Authorize/Reject the request after checking supporting documents are details
updated by maker user. (Refer figure 21)

It is the responsibility of the office to check veracity of documents as provided by the

subscriber.

Figure 21

Subscriber Details

PRAN 110179496534

Back to Results Page
* Changes to be authorized are marked in red

[Status: Active ]

Acknowledgement No. 2002006463

Inward Mo.

Personal Details

Nomination Details

Employment Details

Documemt Upload

View Sign:

Document uploaded by Maker: (USRI EERES LR e c

(@ Authorize () Reject

=>
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18. Message will be displayed on screen once subscriber details change request is authorized

successfully. (Refer figure 22)

Figure 22

CINSDLe-Gov is now Cprotean National Pension System Contributions Accounting Networlg

Welcome Pay and Accounts Office-1001003100 Navigate to CRA 18-Dec-2024 Home | Logout
Contribution Details  Transaction Security  Subscriber Maintenance Views  Tranche2/Regular Fund Dis  Additional Reports (New)  Nodal Officer Details  Aadhaar Linking

Subscriber Details Modification

Back to Resuits Page
PRAN 110179496534
The Subscriber Details Change request has been Accepted.
Acknowledgement No. 2002006463
Authorization Timestamp 2024-12-18 13:09:23




Oprotean

‘ Classification: Public Version No. : 1.2 05-02-2025 Page: 20 of 43 ‘

B. Process to Update Subscriber Bank Details-:

B.1 Request initiation by PAO/DTO office Nodal Office User 1 (Maker)

1. Log in to https://cra-nsdl.com Enter PAO office user Id and password. Click on “Submit”
(Refer figure 23)

Figure 23

E¥ NSDL e-Gow o protean National Pension System (NPS)
Change /s @rownh

The User I/I-FIN you have enb s invalid, please try agsin. For your safety, access to CRA will be locked after 5 consecutive wrong sttempts.

FFRODA has appointed Training agency o provide training on NE 5. Govermment Modal officers can Click hers , Corporates & POPs can Click hers to submit request

Subscribers

Annual Transacson Stasemern on Ema
Umes 5D
Password
ewazal Ltility
Enser Capechas

| uncherstend that,

Activate Tier Il Accaunt Free

FATCA Coampliamoe Helpfinstructions for Login

V)

&

=
o]
=
"=
=
™
=
-l

Krsaw Waur Pensian (NP} MNodal Offices f Other Intermediaries
[ PR Digital Certi
Ulmee B 1001003100
Sufmiscnber Consenl o share contact details with ASP FPasswoed

Enter Capicha

Sunscnber RegistralionPhota rature Modication Request

Status using Receipt Mumber
et el et o I need 1o keep changing my pesseward regulary

PRAN Card Dispatch Status

T Helpinssnsctions for Login

2. Click on option “Transaction”--> "Subscriber Bank Details Update” (Refer figure 24)

Figure 24

&Y NSDL e-Gov s now protean National Pension System (NPS)

Change is growth

Walcoms Pay end ACCOUNts OMGs-1001003100 Navigats to NPSCAN 150802024 Foma | Log
Trancection  Auihorize Request  Coniribulion Dotallz  Securily  AccountDetalls  Subecriber Regiclrabion  Grievance  User Mainimance  DocumentManagoment Views Roporls  Addilional Roports (New)  MasiorDownload  Deshboard  Subscriber Deastivation Reaclivalion  CGMS BackOMfics

et Gl ror Rocimostion oo CSRF Submission Datas  Ext Witnorwal Raquant  Recrument Monoring  Anfual Froazing  Knowiange Gontra
range

Authorize Tramsacson
Tier-2 Activation

Update Subscriber

Delais

Welcome to Central Recordksaping Agency

Tier-2 ko Tier-1

Suitch{Orne Wy Swich) o -
! e Click here to view list of Exit Claim IDs awaiting any action

Undate Subscriver Tiar-2

Detnts

T Subscriber is required to purchase the annuity at the time of Exit. To view annuity quotes. please ciick here View Annuity Quotes

Authorize Subscrives
Shifling Click here for details related to "Voluntary Contribution in Tier | account by Govt. Sector Subseribers’

Capiure D00 Srift Information regarding online submission of FATCA Seff Certiication in Subseribers login may be disseminated to your Subseribers. For detals. Click here
Verify DDO Shift Request Click here for PFRDA Advisory on streamiining of handiing of Exit cases

NPS Operations Guide PAC/D

CRA Helpline for Nodal OFfices 1300-222-081 (toll-frae)

CLAIMID generation

Withdrawal Request Verification

Subssriver Benk Detalis Updats

FATCA Seif Certification

FATCA Fie Upload
FATCA Fie Status

Modal Photo Signature.
Upload

Modal Bank Delails
Update

Subscriber Bark Datais
Update
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3. Click on option Transaction>"“Update Bank Details”-> "Submit” (Refer figure 25)
Figure 25

€Y NSDL e-GovV - ow protean National Pension System (NPS)

Change is growth

er ld: 1001003100 Back to Main Menu

Bank Detail Update

® Update Bank Delails () Authorize Bank Details O view Request Status

Permanent Retirement Account Number (PRAN)Y* 110177047365

Tier Type® Tier 1 ~

m [ﬂTiEI 2

Best viewed in Google Chrome, Mozilla & Intemet Explorer 10+ with a resolution of 1024 X T65. Privacy Policy

4. Existing bank details registered in CRA can be viewed. (Refer figure 26)

Figure 26

£ NSDL e-Gow i now protean Mational Pension System (NPS)

Change is growth

Id: 1001003100

Bank Detail Update

PRAN: 110177047365

SUBSCRIEER NAME: RAMESHWAR VISHVNATH NILA

Existing Bank Details Of Subscriber

Bank Account No 5634545

Bank Account Type SAVING S

IFSC Code uUTIBO0DODO0S

Bank Name ABCF

Bank Branch KOLKATA BRANCH

Bank Address 7, SHAKESPEARE SARANIKOLKATA
Bank Fin Code 999999

Bank State West Bengal

Bank Country India

MICR Code FOO211002
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5. Enter New bank details. Click on declaration and “Penny Drop” option. (Refer figure 27 & 28)

It is the responsibility of the office to check veracity of documents as provided by the
subscriber. Further, the office needs to ensure that the bank details to be updated are
salary bank account only for Govt. subscribers.

In case bank detail entered by nodal office already exists in CRA system will prompt an error
“Duplicate Bank Account Number exists in CRA System. Please try Different combination of Bank
Account number and Bank IFSC Code”

Figure 27

Account Type*
Bank Account No*
Confirm Bank Account No*

Bank IFS Code*
Edit Bank Details

Bank Name*

Bank Branch*
Bank Address”

PIN Code*

State /U.T*
Country*

Bank MICR Code

Bank Account Linked to Aadhaar

| hereby declare that given bank account is salary bank account of the employee as per our office records and atieast one salary has been credited”

$ Penny Drop
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Figure 28

Dupdicate Bank Account Mumber exist im CRA System. Please try Different
Combination of Bank Account number and Bank IFSC Code.

6. On successful “Penny Drop” verification through bank, below message will appear. (Refer figure
29)

Figure 29

Bank Account verification is successful.

In case of penny drop request failure below error message will appear. (Refer figure 30)

Figure 30

Your Bank Account Number verification is successful but there is mismatch
in name between CRA records and Bank records. Please ensure that name
in CRA records and Bank records match.
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7. Please upload scan copy of S2 form duly filled and signed by subscriber and supporting bank
detail proof in system. Click on Submit option. (Refer figure 31)

(Only 'jpeg', 'jpg', 'png' & 'pdf' formats are allowed for document upload with maximum size of 2
MB)

Figure 31

Bank Branch* MUMBAI - GOREGADOMN (EAST)

Bank Address® CGROUND FLOOR . CONWOOD
HOUSE YASHODHAMGEMERAL A K

PIN Code® 400063 Q,

State / U.T.* Maharashira

Country=
Bank MICR Code

Bank Account Linked to Aadhaar

1| hereby declars that given bank account is salary bank account of the employes as per our office records and atieast one salary has been credited*

Upload Document
Froof Hams Attach File
812092024 06_k
Mo file chosen
*o file chosen
Mo file chosen

Oinlne Bank Account Verification will be successful only for Penny Drop with name maitch successful requests.

Only jpeg’. g Py’ & pdf formats are allowead for document upload with macdmum size of 2 MB.

8. Verify new updated details and click on “Confirm"” (Refer figure 32)

Figure 32

EF NSDIL. -G oY - o protean Mational Pension System (N

Cnamrmgme f5 g ol by

Back to Mai

Bank Detail Update

PRAN: 410177047265

SUBSCRIBER NAME: RAMIESHANECWHSERFSEIFE MM

Confirm Bank Details

Bank Account Mo S0 DA A B RR

Bank Account Type SAVING S

IF5C Cods HDFCOO000212

Bank Mame HDFC BANK

Bank Branch MUMEAI - GOREGADMN (EAST)
GROUND FLOOR | CONWOOD

Bank Address HOU SE, vASHODHAMGEMERAL A K. VAIDYA
MARG, MUBMEAIMAHARA SHTRALG00ES

Bank Pin Code 400053

Bank State Maharashira

Bank Country India

MICR Code 4002400327

I hereby declare that given bank account is salary bank account of the employes as per our office records and atieast one salary has been credied*

$ S
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9. On successful initiation of request, the subscriber will be received SMS on registered mobile
number and email ID. (Refer figure 33)

Figure 33

£ NSDL e-Gov - now protean Mational Pension System (NPS)
Change /s growth

Bachk to Main Men

Bank Detail Update

® Update Bank Details Authorize Bank Details View Rieguest Status

Update Bank Details Initiation - Complete

PRAN MM TTOLTIES

Acknowledgement No 80512202418051631

Subsecriber Name RAME SHWAR VISHVNATH NILA

Captured Date 05-12-2024 16:07:48

10. To check the status of request, click on option Transaction>“View Request Status”-> Submit.
(Refer figure 34)

Figure 34

Bank Detail Update

Acknowssdgemsant Number
PRAN

Thar Type

Status

From Dates

To Dates

-
Reqguest ﬁEr Type of Maker Entity _ Pending
_- o s = e fastAetion Taken e

S0S1220Z4150516391 05-12-2024 | 110177047365

INTITIATED BY MODAL
Modified AO010031 Pending office Authorizer

e

From Date and To Date will be the request capture date of Bank Detsils Change
Emer any one search criteria. Esthver Acik viedgment NMumber or PRAN or from Date and to Date
The difference From and To Dats cannot be greater than 15 days

Please note the office is required to click on the declaration confirming that the given bank
account is salary bank account of the employee as per office record.
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B.2 Request Authorization by PAO/DTO office Nodal Office User 2 (Checker/Authorizer)

11. Nodal office will log in to CRA (https://cra-nsdl.com) with user ID 2 (Checker/Authorizer) (Refer

figure 35)
Figure 35

¥ NSDL e-Gov o« protean

Change /s growth

Mty Withl ramazal Utility

Inwest in KPS

Activate Tier || Account Free !

FATCA Comgliamnoe

Knaw Your Pensian (MPF)

Sutiscriber Consent to share conl

Suhscriber RegistrationPhoto-Sigrature ModiScation Request
Siatlus using Receipl Mumber

PRAMN Card Dispatch Stz

Mational Pension System (NPS)

Uses ID

FPassword

Enter Captcha

| understand that,

& nal ta be disdased.
e1ly Lrmed fext o

My User IDIFRAN & Password
Password should be complex and

Reset Passwanrd 1PN for eNE'S Hedp/instructions for Login

Modal Offices / Other Intermediaries
(R T

Us=er ID 1001003101

Digital Certi

Password

Enler Cs

| understand that,

& nat o be discdased.
rily Lemed fext o

My User IDIFRAN & FPassword
Password =hould be complex and r

— ] Helpdinstrsctions for Login

12. Click on option Transaction--> “Subscriber Bank Details Update”-> Authorize Bank Details

(Refer figure 36)

Figure 36

3 NSDL e-Gov & o protean

Change is grawth
Welcom Pay and Acopunts OMEe-1001005100
Transachion  Auinonizo Reguest  Coniribufion Detais  Secunly  Account Detals

E F Error Rectification Module
Changs

CERF Submigelon Delall  Exit Withdrawal Request  Recruliment Monitoring  Annual Freezing  Knowiedge Centro

Auihorize Transacson
Tier-2 Activation

Update Subscrizes
Detais

Tier-2 1o Tier-1
SwilchiOne Way Switch)

Update Subscribes Ter2
Detais

Subscriver Reqisiraion  Griovance  User Mainionance  Document Managoment  Views

onal Pension System (NPS)

05Dac 2024
‘subBcriber Deactvation | Reachvation

Mavigats to NPSCAN
Amfional Reports (New)  Master Download  Dasnboard

Homa | Log

Roparts CGMS Backommoa

Welcome fo Central Recordkeeping Agency

Click here to view list of Exit Claim IDs awaiting any action

T Subscriber is required to purchase the annuity at the time of Exit. To view annuity quotes. please click here View Annuity Quotes

Autharize Subscrier
Shifing Click here for details related to ‘Voluntary Contribution in Tier | account by Govt. Sector Subscribers™

Capiure D00 Shift Informatien regarding online submissicn of FATCA Seff-Ceriification in Subseribers login may be disseminated to your Subseribers. For detads. Click here

Very DDO SHift Request Click hers for PFRDA Advisory on streamiining of handiing of Exit cases
Ausvarize DO Shit NPS Operations Guide FAD Do
CRA Helpiine for Nodal Offices 1800-222-081 (tolkfres)

CLaIM 1D genaration
Iritiale Condifianal
Wiitiraswcl

Withdrawal Request Verification
Verify Condiional
Withdrawal Reguest

Subscriber Bank Detalis Updats
FATCA Seif Cerlification

FATCA Fie Upload

FATCA Fie Staus

Nodal Photo Sigrature.
I

Nadal Bank Details
Update

Subscriber Bank Datals
Update
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13. Enter PRAN/Acknowledgement details> Submit (Refer figure 37)

Figure 37

National Pension System (NPS)

€9 NSDL e-Gow i ow protean
Change is growth
EBack to Main Men

Bank Detail Update

' Update Bank Details @) Authorize Bank Details _ \Miew Request

Authorize Bank Details

Acknowledgement Number

PRAN 110177047385

—SELECT—

gmm

Mote

{ =  From Date and To Date will be the request capture date of Bank Details Change

{ = Enter any one search criteria, Either Acknowledgment Number or PRAM or from Date and to Date
he difference between the From and To Date cannot be greater thanm 15 days

14. Click on Hyperlink “Acknowledgement Number” to check and verify the details. (Refer figure

38)

Figure 38
£ NSDL e-Gow i now protean National Pension System (NPS)
Change is growth
Eack to Main Men

er ld: 1001002101

Bank Detail Update
() Update Bank Details @) Authorize Bank Detais 2 Wiew Request Status

Authorize Bank Details

Acknowledgement Number

FRAN 1101770473685

—SELECT—

Acknowledgement Request b T £ Maker E
sl = == Request For rer Les aker Entity Last Action Taken
Mumber Date Type Transaction o
INTITIATED BY
Approve/Reject

Modified 100100321 Pending NODAL

E0512202418051691 05-12-2024 | 110177047365
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15. Details of pending request will be visible along with status. Click on Hyperlink “Click Here to
Check Bank Details” (Refer figure 39)

Figure 39

Reguest Raize

PRAM 110177047 3635
Tiar Type ™

RAME SHWAR

Submcrines Hams WISHVMATH MILA

Makar Entity 10 100400F1

Makar Uasr 1D 100100
Achnowiadgemsant Humibar S05122024 18051591
achk Generated Date 05-12-2024

Curmant Status INTITIATED BY MODAL
Penny Drop Status Penny Drop Success

Raquesat By Lewel 2 Emtity

Click Here to Check Bank Details

Ho=dal Imidaior

mm— e =

RECHJEST

10010031 10010031 00 OS5-12-2024 RAISED

16. Office can view and download the supporting documents uploaded while initiating maker
request.
To authorize/reject the request close existing preview. (Refer figure 40)

It is the responsibility of the office to check veracity of documents as provided by the
subscriber.
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Figure 40
Meww Banlk Details o WWpdaite

Eank Ac-coumnt Mo SO0 SdA i aa a7

Eank A cooumt Types SAWTMIE S

IF 8:.C Coda HIDFCOOMeD21 2

Bank Mames HIHFC EAME

Eank Brancn MUMEA] - SOREGACOM (EAST)
GROUND FILOOR | OO

HOUSE. YA SHODHAMGEMERAL A K.

WY
MERG, MILAE SIS HA A SHTRASADDD0E S

Bank Addreas

Eank Pin Code LSS
Bank Stats Maharashtra
Eank Coumiry Imdia
MINCR Caode A ZA0OET
I hereby declars thiat given bank
acocount is salary bank accownt of the
ODaclaraticn By Hodal WwariTler employase as per our office necords

and atleast one salary has bean
credifbe-d

Uplosded Do urments™

Dhossmrload Attachead File

-

—

SURSCRIBEER
RSDHIF TN AT 1O F

17. To approve /reject the request, select click on hyperlink under tab “Action” (Refer figure 41)

Figure 41

W NSDL e-Gowr oo Oprotean Mational Pension System (NP
Change fs mrowoh

Back to Main

Bank Detail Update
Authorize Bank Details

Acknowisdgemeant Humber

PRAN

St E
Request Tier Type of Mlzkoer Entity _
=t Fi Last Action Tak: Action
_- L = =

05-12-2024 | MMO0I7FT0472I6S Mo-dified 10100321 FPending IH“::_:?DAE =0 Approve/Reject

18. Remarks can be entered while authorization of request if any. Click on “Approve” (Refer figure
42 & 43)
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Figure 42

Bank Detail Update

Achnowisdpurent Rumbee: B 2202415061861 HEH 1T T

FHAR- HINTTO4TIEE supscHsEH Havs:  RAMESRRERN PRGN

Authorize Subscriber Bank Detalle

Hew Subscriber Bank Detalls

Bunk Accoutt Ha B DS F AT
Bunk Account Iyps BEVING 2
50 Code HOFCOD0ET2
Bk Murms HOFZ: BANKE
Eunk Eranch MUMEE] - BOREGA0N [EAAT)
SROUND FLOOR , COMWDOD
HOUZE, ¥& 3HDODHAMOENERAL A K. WAIDYA
MARG, MUMEAINAHARA SHTRALDEE
Bk I%in Code ]
Bk Sute Mzharachin
Bk Courtry Indix
HIGH Lode SN140017
| hesraityy decdare thed given bank acocunt
I calary bank apcount of the smployes

as par cur offics recornds and sflsact one
calary hac besn oredisd

L et Sy Model Yerter

Famanks

=> mm =

Figure 43

Do you want to Proceed 7
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19. On successful authorization below message will be displayed on screen. (Refer figure 44)

Figure 44

Bank Details Change

Request has been successfully Accepted

Acknowledgement Number  80512202418051691
PRAN 110177047365«

RAMESHWAR

i N
Subscriber Name VISHVNATH

Requested Date 05-12-2024 16:05:52

20. To check the status of request, click on option Transaction>“View Request Status”-> Submit.
(Refer figure 45)

Figure 45

Bank Detail Update

() Update Bank Details ) Authorize Bank Details @ View Request Status

View Request Status

Acknowledgement Number
PRAN 110177047365
—SELECT--

—SELECT—-

-
Acknowledgement Reguest Ter Tvpe of Maker Entity Pending

Authorized by Nodal

B0512202418051691 05-12-2024 | 110177047365 ™ Modified 10010031 Accepted office

Completed
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C. Process to Update Subscriber Nomination Details

C.1 Request initiation by PAO office Nodal Office User 1

1. Log in to https://cra-nsdl.com Enter PAO office user Id and password. Click on “Submit”
(Refer figure 46)

Figure 46

£ NSDL e-Gowv - Oprotean Mational Pension System (NPS)

Change s growsh
The User 1-FIN you have en imalid, ple=se try agsin. For your safety, access to CRA will X ive twempts.

PFROA has appointsd Training sgency to provids training on NP S, Gowvemiment Modal officers can Click hers . Corporatss & POP= can Click hers to submit request

Subscribers

Uses ID
Panzword
bt rzmwal Ltility
exr Coan e
1 understnd th

By User IDVERAN & Fassww
shoubd be comgles and nol comrenonly emed

nging iy pammwand regularhy.
Tier Il Acoaunt Fr

FATCA Campliance

IBEN for ehES E =tructions for Login

K Waur Pensian 1 MNodal Offices / Other Intermediaries
[C R Drigital Cert
User ID 1001003100

Suliscriber Consent o shane can i 3 FPassword

Enter Capichs S I3y 2
Suhscriber Registration/Phoso
B3 | understand that,
Ry Ulser IDIERAN & :
Pasmword should be complex 3 comemonty umed text o
Statu= using Receipt Musmnber K - o
e . pesm=ward regulary.

FFUAN Card Drapaich Statis ===

2. Click on option “Transaction”--> “"Update Subscriber Details” (Refer figure 47)
Figure 47

& NSDL e-G oV - now Oprotean National Pension System (NPS)

Change is growth

lelcome Pay and Accounts Office-1002287900 Navigate to NPSCAN 04-Dec-2024 Home | Logout
Transaction  Authorize Req; rlevance  User Maintenance  Document Management  Views Reports  Additional Reports (New)

Scheme Preference rawal Request
Change AR Rl

Authorize Transaction
Tier-2 Activation

Update Subscriber
Details

Tier-2 to Tier-1

Switch(One Way Switch)
Welcome to Central Recordkeeping Agency

Update Subscriber Tier-2

Details

Subscriber Shifting

Click here to view list of Exit Claim IDs awaiting any action

Authorize Subscriber Subscriber is required to purchase the annuity at the time of Exit. To view annuity quotes, please click here View Annuity
hifting

Capture DDO Shirt Click here for details related to ‘Voluntary Contribution in Tier | account by Govt. Sector Subscribers’ .
est Subscriber-Shifting Source

Verify DDO Shift Request Information regarding online submission of FATCA Self-Certification in Subscribers login may be disseminated to your Subscribers. F¢ [ Authorization
AaDcEe DRO Shit Click here for PFRDA Advisory on streamlining of handling of Exit cases Subscriber Bank Details Update
DDO Shifting Request NPS Operations Guide PAO/DTO DDO -

Status View

CRA Helpline for Nodal Offices 1800-222-081 (toli-free)
Initiate Conditional
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3. Enter PRAN of subscriber under “Subscriber Details View"” option. Click on “Submit” (Refer
figure 48)

Figure 48

£ NSDL e-GovV : won protean National Pension System (NPS)

Change is growth

Welcome Pay and Accounts Office-1002287900 Navigate to NPSCAN 04-Dec-2024 Home | Logout

Transaction  Authorize Request  Confribution Details ~ Security  AccountDetails  Subscriber Regisiration  Grievance  User Maintenance  Document Management Views Reporis  Additional Reporis (New)
Master Download Dashboard  Subscriber Deactivation / Reactivation ~ CGMS BackOffice  Nodal Offices Upload  Emor Rectification Module ~ CSRF Submission Details  Exit Withdrawal Request

Recruitment Monitoring ~ Annual Freezing  Knowledge Centre

»  Subscriber Details View

* Mandatory Fields

Submit

Retived Life ka sahara, NPS hamara

Home | Contact Us | System Configuration / Best Viewed | Entrust Secured | Privacy Policy | Grievance Redressal Policy

4. Click of “Edit” option to enter New details. (Refer figure 49)

Figure 49

{3 NSDL e-Gov o protean National Pension System (NPS)

Change is growth

Welcome Pay and Accounts Office-1002287900 Navigate to NPSCAN 04-Dec-2024 Home | Logout
Transaction  Authorize Request  Contribution Details  Security  AccountDetails  Subscriber Registraion  Grievance  UserMaintznance Document Management Views Reports  Additional Reports (New)  Master Download

Dashboard  Subscriber Deactivation | Reactivation — CGMS BackOffice  Nodal Offices Upload ~ Emor Rectification Module  CSRF Submission Details  Exit Withdrawal Request  Recruitment Monitoring ~ Annual Freezing  Knowledge Centre

»  Subscriber Details

PRAN 110014675754  [Slatus: Active ]

Name SHRI TVNJHV GHOTH
PRAN aclivation date 1900312015

For Bank Details modification - Use New link 'Update Bank details'
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5. To check the existing nomination details please click on Nomination Details tab. (Refer figure
50)

Figure 50

Subscriber Details

PRAN 110179496534 [Status: Active ]
Inward No. I

Miew Signature

Personal Details
Nomination Details
Employment Details

KYC Details

Note: Providina current address is mandatory

6. Under Section “Nomination Details”, nodal office can Remove existing details and Add new
nominee details. (Refer figure 51)

Maximum up to 3 nominees can be entered.
Percentage Share for all nominees should not exceed more that 100%
In case nominee is “Minor” Guardian details are mandatory.

It is the responsibility of the office to check veracity of documents as provided by the
subscriber.

Figure 51

Nomination Details

Nominee 1

First Name * MANJU Middle Name Last Name GHOSH
Date of Birth B Relationship = [MOTHER | Relationship Other

B (ddimmiyyyy)
Percentage Share * (50 |
%
%
MajorMinor * MA Mominee Age *

Guardian First Name | Guardian Middle Name ] Guardian Last [
. . Name

Flatfroom/Door/Block Premises/Building/Village Areal/Locality/Taluka
No
City State [SELECT w | Country [SELECT

PinCode Nominee Invalid m
~ Condition
Nominee 2
First Name * [maDHOB | Middie Name Last Name [GHoSH ]

Date of Birth Relationship = FATHER Relationship Other

D (adimmiyyyy)

Percentage Share * |50
%

Major/Minor * Ll Mominee Age *
Guardian First Name Guardian Middle Name Guardian Last

Name

FIaUrnon\u‘Doon'B\ock[ | Premises/Building/Village | ] Area/Locality/Taluka [
No

City | State [SELECT ~ | Country [SELECT
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7. Nodal office is required to Upload supporting Proof i.e. S2 Form signed by subscriber along
with supporting documents. (Refer figure 52 & 53)

Uploaded Attachment/Allowed file types: pdf/xIs/png/doc/xIsx/jpeg/docx/zip/jpg.
Maximum File Size Limit: SMB.

Only 1 document can be uploaded.

File Name should not have special characters or space.

Figure 52

£ NSDL e-GovV o O protean National Pension System (NPS)
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Welcome Pay and Accounts Office-1002287900 Navigate to NPSCAN 05-Dec-2024 Home | Logout

Transaction  Authorize Request  Contribufion Defails  Security AccountDefails  Subscriber Registrafion  Grievance  UserMaintenance  Document Management Views Reporfs  Additional Reports (New)  Master Download  Dashboard

Subscriber Deactivation | Reacfivation ~ CGMS BackOffice  Nodal Offices Upload  Error Recfification Module  CSRF Submission Defails  Exit Withdrawal Request  Recruitment Monitoring  Annual Freezing  Knowledge Centre

»  Subscriber Details

PRAN 10162887572 [Status: Active ]
Inward No.

Personal Details
Nomination Details
Employment Details
KYC Details

Document Upload

Salect File to upload * Mo fila chosan

{Nate - Uploaded Attachment/Allowed file types - pdf xfz. png, doc xizx, joeg, docx, 2ip ipg.
Maximum File Size Limit : 58B. Number of Files can be uploaded 1)
Kindly upload 52 Form. Form upload is mandatary for Subscriber Modification request
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Figure 53

File uploaded successfully

8. Updated details entered in CRA system will be highlighted in Red Color text.
Office may verify the details and click on “Submit” option. (Refer figure 54)

Figure 54

MNomination Details

Mominge 1
Hamne abhdtdg Date OF Birth
Relationship FATHER Relationship Other
Percentage Share 100% Mominee Age
MajorMinor MAJOR Guardian Mame
FlatRoomDeonBlock no. Premises/Building/Village
Areallocality Tzluka City
State Country
Fin Nominee Invalid Condition

Employment Details
KYC Details

Document Upload

Select File to upload * sample PDF

{Note : Uploaded Attachment/Allowed file types : pdf iz png doc xlzx jpeg doc: zip jog.
Maximum File Size Limit : S4B, Number of Filez can be uplosded 1)

Kindly upload 52 Form. Form updoad is mandatory for Subseriber Modification request
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9. Message will be displayed on screen once subscriber details change request are captured
successfully.
Acknowledgment number will be displayed on screen. (Refer figure 55)

Figure 55
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Welcome Pay and Accounts Office-1002287900 Navigate to NPSCAN 05-Dec-2024 Home | Logout
nsaction  Authorize Request  Confribuion Details ~ Security  AccountDetails  Subscriber Registrafion  Grievance  UserMaintenance  Document Management Views Reports  Additional Reports (New)  Master Download  Dashboard

bscriber Deactivation | Reacivaion  CGMS BackOffice  Nodal Offices Upload  Error Rectification Module  CSRF Submission Details  Exit Withdrawal Request  Recruitment Monitoring  Annual Freezing  Knowledge Centra

Subscriber Details Modification

PRAN 110162887572

The Subseriber Details Change request has been Acoepted.

PENDING AUTHORIZATION

Agknowledgement Mo, 2302157151
Capture Timestsmp 2024-12-05 10:55:47

10. Status of request can be checked under option:
View---> Request Status -View—> Transaction Type-> Enter PRAN/ Acknowledgment number (Refer
figure 56 to 59)

Figure 56
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Welcome Pay and Accounts Office-1002287500 Navigate to NPSCAN 05-Dec-2024 Home | Logout
Transaction  Authorize Request  Confribufion Details  Security  AccountDefails ~ Subscriber Registrafion ~ Grievance  UserMaintenance  Document Management Views Reports  Additional Reports (New)  Master Download  Dashboard

Subscriber Deactivation | Reactivation ~CGMS BackOffice  Modal Offices Upload  Error Rectification Module  CSRF Submission Details  Exit Withdrawal Request  Recrufli=p gyl Syl Freezing ~ Knowledge Centre
Subscriber Refirament

Details
PAQ Performance

»  Subscriber Details Request Status - View
PAD Views
DDO Viens
Subseriber Tier-2 Details

FRAN 10162887572 [Status: Active ] Withdrawal Exit Cizim 1D
Repart

e No. [
(Conditional Withdrawal

Request Staus View View: Signature

eFRAN

Personal Details PRAQ Views +

‘Subscriber Shifting-ist
Statement of Voluntary

Nomination Details Contribution under Mational
Pension System(NPS)
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Figure 57
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Welcome Pay and Accounts Office-1002287900 Navigate to NPSCAN 05-Dec-2024 Home | Logout
jansaction  Authorize Request  Contribution Details Security  Account Details Subscriber Registration ~ Grievance  User intenance  Document Management Views Reports  Additional Reports (New) Master Download  Dashboard

criber Deactivation / Reactivation ~ CGMS BackOffice  Nodal Offices Upload  Error Rectification Module  CSRF Submission Details  Exit Withdrawal Request  Recruitment Monit

» Status of Maintenance Request

Transaction Type * Select
PRAN | sekect

Ack No/PRN ** | scheme Preference Change

Capture From Date
‘Subscriber Details Change )
Capture To Date
| subscriver Shift Request oy}
| Tier-2 Registration Request
; Tier-2 Modification Request
Note
> Plasse enter the Ack No. or PRNIRecsipt numbar provided by the Nodsl OFice/™ one Way Sitch r of the Maintenance request

Figure 58
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Welcome Pay and Accounts Office-1002287500 Navigate to NPSCAN 05-Dec-2024 Home | Logout
ransaction  Authorize Request  Contribufion Details ~ Security  AccountDetails  Subscriber Registrafion  Grievance  UserMaintenance  Document Management Views Reports  Addifional Reports (New)  Master Download  Dashboard

ubscriber Deactivation | Reacivation  CGMS BackOffice  Nodal Offices Upload  Error Rectification Module  CSRF Submission Defails ~ Exit Withdrawal Request  Recruitment Monitoring  Annual Freezing  Knowledge Centre

»  Status of Maintenance Request

* Mandatory Fields

Transaction Type * ‘Subseriber Detals Change v
PRAN 10152887572
sechpan —

Capture From Date 1 @ccur-n-n-ym)
Capture To Date | ) J
) (ddimmiyyyy)

==
Note

? Please enter the Ack No. or PRNReceipt number provided by the Nodal Office/POP-SP at the time of submission of the Maintenance request.
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Figure 59
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Welcome Pay and Accounts Office-1002287500 Navigate fo NPSCAN 05-Dec-2024 Home | Logout
Transacion  Authorize Request  Contribufion Details ~ Security  AccountDefails  Subseriber Registrafion  Grievance  UserMaintenance  Document Management Views Reports  Additional Reports (New)  Master Download  Dashboard

Subscriber Deackivafion / Reacfivation ~ CGMS BackOffice  Nodal Offices Upload  Error Rectification Module  CSRF Submission Details ~ Exit Withdrawal Request  Recruitment Monitoring  Annual Freezing  Knowledge Centre

»  Status of Subscriber Change Request Status Results

CVVHWIZVC
10162887672

Sr.No. AcknowledgementMo.  Request Received Dale Request Type: Status. DDOApproved  DDOApproval Date  Aufo-Processed  Request Authorizafion Date  Reason of Rejecfion
1 2302157151 (5-12-2024 Subseriber Change Request Status Pending Authorisation - No - -




Oprotean

‘ Classification: Public Version No. : 1.2 05-02-2025 ‘ Page: 40 of 43 ‘

C.2 Request Authorization by PAO/DTO office Nodal Office User 2 (Checker/Authorizer)

11. Nodal office will log in to CRA (https://cra-nsdl.com) with user ID 2 (Checker/Authorizer) (Refer
figure 60)
Figure 60

E¥ NSDL e-Gow - aow U protean Mational Pension System (NPS)
Change #s growth

5 & POPs can Click here to submit requests on behalf of subscriber to parScipate in these traiming sessions. | Indnadual Subscribers can Clhck here bo parbopate in fhese trammang S

Annusl Transsction Statement on Email Subscribers
User ID

Fassword

Enter Gaptcha 8 2 + 5 =

My Wit rawwal Uitility

)1 unoerstana that,
Inwest in NPS
= My User IDVFRAN £ Passweord is confidental & not o be disclosed.
- Password should be complex and not commonty used text or
number
I nead to keep changing my password regulardy.
Activate Tier Il Account |

FATCA Compliance Feses Password IEIM for eMNPS Help/instructions for Login

Korvow Yousr Pansion (MPF) MNodal Offices f Other Intermediaries
& 1P CODighal Gertficate
User ID 1002287801

Subscriber Consent to share contact details with ASP Fassword
Enter Capichs
Subscriber Registration/Photo-Signature Modification Request B wrcterstand that

My User IDVPRAN & Password is confidential & not to b= disclosad.
Password should be complex and not comemonty used text or
. § number.
Stares wsing Recsipt Mumb=r I need to kesp changing my password regulariy.

FRAM Card Dispatch Status. m

Help/instructions for Login

12. Click on menu “Transaction”-> “Authorize Transaction”. Enter Transaction Type and PRAN
details. Click on “Search”. (Refer figure 61)

Figure 61
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Welcome Pay and Accounts Office-1001003100 Navigate to NPSCAN 05-Dec-2024 Home | Log

Transaction  Authorize Request  Contribution Details ~ Security  Account Details  Subscriber Registration  Grievance  User Maintenance  Document Management Views Reports  Additional Reports (New)  Master Downlog

gﬁheme Preference Deactivation / Reactivation  CGMS BackOffice  Nodal Offices Upload  Emor Rectification Module ~ CSRF Submission Details  Exit Withdrawal Request  Recruitment Monitoring  Annual Freezing  Knowledge|
ange

Authorize Transaction
Tier-2 Activation
Update Subscriber Details »  Autherize Transaction

Tier-2 to Tier-1 Switch{One
Way Swilch)

Update Subscriber Tier-2 * Mandatory Fields
Details Transaction Type * [ Subscriber Details Change v
Subscriber Shifting PRAN
e
Authorize Subscriber =
= ke —

Capture DDO Shift Request To Date I:| @(ddfmm{myj
Veerify DDO Shift Request

Authorize DDO Shift @ @
Request

DDO Shifting Request
Slatus View

Initiate Conditional > *#* Enter PRM/Receipt No for Switch transaction and Ack Mo./Receipt Mo. for other fransactions.
‘Withdrawal

Verify Conditional
Withdrawal Request
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13. Click on hyperlink “View Details” to check the new details updated by maker user. New
updated Details are highlighted in Red Color text. (Refer figure 62 & 63)

Figure 62
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Welcome Pay and Accounts Office-1002287901 Navigate to NPSCAN 05-Dec-2024 Home | Logout
Transaction  Authorize Request Contribution Details ~ Security  AccountDetails  Subscriber Registration ~ Grievance  User Maintenance  Document Management Views Repors  Additional Reports (New) Master Download

Dashboard  Subscriber Deactivation / Reactivafion ~ CGMS BackOffice  Nodal Offices Upload  Emor Rectification Module  CSRF Submission Defails  Exit Withdrawal Request  Recruitment Monitoring ~ Annual Freezing  Knowledge Cenfre

»  Authorize Transaction

* Mandatory Fields

e R v e —
PR
P —

From Date : d(dd{mmfmy)
To Date :| d(dd{mmfmiy)

L ows v

> ** Enter PRN/Receipt No for Switch transacfion and Ack No./Receipt No. for other transactions.

Acknowledgement No Subscriber Name Date Of Request Capture DDO Approval Date Link to Detrils

2302157151 |CVWH_ WKZVC 051122024 View Defails

Figure 63

Nomination Details

Momines 1
MName abhdtdg Date Of Birth
Relatonship FATHER Relatianship Other
Percentage Share 100% Nominee Age
Major/Minor MAJOR Guardian Name
FlatReomDoorBlock no. Premises/Building/Village
Area/Locality/Taluka City
State Country
Fin MNominee Invalid Condition

Employment Details

$ ® Authorize O Reject
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14. Office may Authorize/Reject the request after checking supporting documents are details
updated by maker user. (Refer figure 64)

It is the responsibility of the office to check veracity of documents as provided by the
subscriber.

Figure 64

> Subscriber Details

Back to Results Page
* Changes to be authorized are marked in red

PRAN 110179496534 [Status: Active ]

Acknowledgement No. 2002006463
Inward No.
View Sign;

Personal Details
Nomination Details

Employment Details

Documemt Upload

Document uploaded by Maker: WRYTETRIGGELEL R | @

: ® Authorize ) Reject

15. Message will be displayed on screen once subscriber details change request are

authorized/rejected. (Refer figure 65)

Figure 65
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Welcome Pay and Accounts Office-1002257901 Navigate to NPSCAN 05-Dec-2024 Home | Logout
ransacfion  Authorize Request Contribution Details Security  Account Details Subscriber Registration  Grievance User Maintenance  Document Manapgement  Views Reports  Additional Reports (New)  Master Download

[Dashboard  Subscriber Deactivation / Reactivation  CGMS BackOffice Nodal Offices Upload  Emor Recfification Module  C SRF Submission Details Exit Withdrawal Request  Recruitment Monitoring  Annual Freezing  Knowledge Centre

»  Subscriber Details Modification

Back to Resulls Page

PRAN 110162887572

The Subscriber Defails Change request has been Accepted

Acknowledgement No. 2302157151
Authorization Timestamp 202412-05 11:02:36
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16. Status of request can be checked under option-:

View -> Request Status -View> Transaction Type-> Enter PRAN/ Acknowledgment
number->Search (Refer figure 66 and 67)

Figure 66
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Weicome Pay and Accounts Office-1002267901 Navigate to NPSCAN 05-Dec-2024 Home | Logout
Transaction  Authorize Request  Contribution Details  Security  AccountDetails  Subscriber Registration  Grievance  User Maintenance  Document Management  Views  Reports  Additional Reports (New)  Master Download

Dashboard  Subscriber Deactivation / Reactivation ~ CGMS BackOffice  Nodal Offices Uplosd  Error Rectification Module  CSRF Submission Details  Exit Withdrawal RedUae LU Ui U lling  Annual Freezing  Knowledge Centre
Subscriber Retrement
Detais

PAQ Performance
>  Status of Maintenance Request Request Status - View
PAD Views

DOO Views

= Subscriber Tier-2 Detais
Transaction Type * [ Scbscrber Detads Crange V|

PRAN 110162887572
Ack NoJPRN **
Capture From Date

Withdeawal Exit Claim 1D
Report

Conditional Withdrawal
Request Status View

If' (edmmiyyyy) = 3

Capture To Date .
3 (adimmyyyy) PRAO Views

oD Sty

Statement of Voluntary
Note Contribution under National

> Please enter the Ack No. or PRN/Receipt number provided by the Nodal Office/POP-SP at the Bime of submission of the Maintenance request. T csion System(NPS)

Figure 67
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Welcome Pay and Accounts Office-1002287901 Navigate to NPSCAN 05-Dec-2024 Home | Logout
Transaction  Authorize Request  Contribution Details Security  Account Details  Subscriber Registration  Grievance User Maintenance  Document Manapement Views Reports  Additional Reports (New) Master Download

Dashboard  Subscriber Deactivation / Reactivation CGMS BackOffice  Nodal Offices Upload  Emor Rectification Module  CSRF Submission Details  Exit Withdrawal Request  Recruitment Monitoring ~ Annual Freezing  Knowledge Centre

»  Status of Subscriber Change Request Status Results

CVVH WXZVC
110162887572

Sr. No. Acknowledgement No. Request Received Daie Requesi Type Status DDO Approved DDO Approval Date Auto Processed Request Authorization Date  Reason of Rejection
1 2302157151 05-12-2024 Subscriber Change Request Status  Authorised at NPSCAN - - No 05-12-2024 -
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